
 Worksheets 

1. History of Computers

A. Fill in the blanks.

 1. Stones, sticks, ________, pebbles and _______were used by early men to count.

 2. ___________ counting devices were made after early counting devices.

 3. ________ was the first calculating devices invented in China to count large numbers.

 4. Gottfried Wilhelm Von Leibniz built a calculator called _____________ in 1671.

 5. ______________, a mathematics professor, designed an automatic calculating machine in 1822.

B. State whether the following statements are True or False. 

 1. The limitations of ten fingers and ten toes caused man to construct tools for calculations.

 2. In 2016, John Napier invented Napier’s Bones.

 3. Pascaline was the first mechanical calculator invented in 1649 by Charles Pascal.

 4. George Boole is called the Father of Computers.

 5. Charles Babbage designed the Boolean Logic.

C. Match the columns.

  Column A   Column B

 1. 1822 (a) Pascaline 

 2. 1616 (b) Jacquard Loom 

 3. 1642 (c) Leibniz Calculator 

 4. 1671 (d) Difference Engine

 5. 1801 (e) Napier’s Bones

D. Choose the correct answer.

 1. Who among the following designed Boolean Logic?

 (a) Charles Babbage   

 (b) George Boole

 (c) Herman Hollerith   

 (d) John V. Atanasoff

 2. ENIAC and UNIVAC were electronic digital computers built in which of the following countries?

 (a) USA   

 (b) USSR

 (c) UK   

 (d) China



 3. What was the first computer prototype called?

 (a) Z3   

 (b) Difference Engine

 (c) Atanasoff-Berry Computer 

 (d) Jacquard Loom

E. Answer the following questions.

 1. Why is Charles Babbage called the Father of Computers?

 2. Write a few lines about the first computer prototype.



Answers to Worksheet

A. 1. fingers, cowries   

 2. Mechanical  

 3. Abacus   

 4. Leibniz Calculator  

 5. Charles Babbage

B. 1. True 2. False 3. False 4. False 5. False

C.  1. (d) 2. (e) 3. (a) 4. (c) 5. (b)

D. 1. (b) 2. (a) 3. (c)

E. 1. In 1823, Charles Babbage thought of a mechanical construction which was known as 
mechanical-digital computer. It could also prepare mathematical tables. Babbage called 
this Analytical Engine. This provided a base for the development of modern computer. Thus, 
Charles Babbage is rightly called the Father of Computers.

 2. John V. Atanasoff and Clifford E. Berry developed the first computer prototype. It consisted of 
vacuum tubes instead of mechanical switches. It was called Atanasoff-Berry Computer (ABC). 
It used the binary number system like a modern computer. This was called the first digital 
electronic computer—ABC.



2. Know Your Computer

A. Fill in the blanks.

 1. A computer works on the principle of ________________ (IPO) cycle.

 2. All the physical devices of a computer that we can see and touch are called _____________.

 3. A ________ is a camera that helps us to put images into a computer by directly clicking them.

 4. A __________ contains a grid of buttons called _______.

 5. A _________ is a pointing device that is shaped and held like a pen.

B. State whether the following statements are True or False. 

 1. An input device accepts input in the form of data and instructions.

 2. Devices used to feed information, data and instructions to a computer are input devices.

 3. A scanner is an input device that is used to play games on computers.

 4. An output device displays the result of the input after it has been processed.

 5. Central Processing Unit is the processing device of a computer.

C. Match the columns.

  Column A   Column B

 1. Input Device  (a) Laser Printer

 2. Output Device  (b) Adobe Photoshop

 3. Processing Device  (c) Floppy Disk

 4. Storage Device  (d) Graphic Tablet 

 5. Application Software  (e) Central Processing Unit (CPU) 

D. Choose the correct answer.

 1. Which of the following is not a component of CPU?

 (a) Control Unit   (b) Arithmetic Logic Unit

 (c) Memory Unit   (d) Printer

 2. Which of the following is not a system software?

 (a) Windows   (b) Mac OS

 (c) CorelDraw   (d) Linux

 3. 1024 Kilobyte is equal to how many Megabyte(s)?

 (a) 8   (b) 3

 (c) 1   (d) 2

E. Answer the following questions.

 1.  What is system software?

 2.  What are the different components of a Central Processing Unit?



Answers to Worksheet

A. 1. Input–Processing–Output   

 2. hardware  

 3. webcam     

 4. keyboard, keys  

 5. light pen

B. 1. True 2. True 3. False 4. True 5. True

C. 1. (d) 2. (a) 3. (e) 4. (c) 5. (b)

D. 1. (d) 2. (c) 3. (c)

E.  1. Software is a set of instructions that tells a computer to perform a specific task. System 
software manages and controls computer hardware and allows them to work together. 
Without the system software, a computer cannot operate as a single unit. Operating systems 
such as Windows, Mac OS and Linux are a few examples of system software.

 2. Central Processing Unit (CPU) is the processing device of a computer. It is called the brain of 
a computer. It processes the inputs given to a computer. It has three main components.
�� Control Unit (CU): The CU coordinates various operations of a computer.
�� Arithmetic Logic Unit (ALU): The ALU is responsible for performing various arithmetic 

operations such as addition, subtraction, multiplication and division. It also performs 
relational and logical operations such as equal to, greater than, less than and not equal to.

�� Memory Unit (MU): The MU stores information in the form of instructions and data. It is 
divided into Random Access Memory (RAM) and Read Only Memory (ROM).



3.  More on Windows 10

A. Fill in the blanks.

 1. Windows provides ____________ where graphics are used to communicate with a computer.

 2. The initial screen that appears after the computer is started is called the __________.

 3. When you click on the __________ button, it displays major options along with the live tiles.

 4. ____________ is used to manage files and folders.

 5. ____________  means to create a duplicate copy of a folder without deleting it from the 
original location.

B. State whether the following statements are True or False. 

 1. Windows is multi-user operating system and has a number of inbuilt programs.

 2. The Power button is the most used button on the Windows desktop.

 3. A folder is a collection of files. A sub-folder is a folder within a folder.

 4. Double-clicking on a folder deletes it from its current location.

 5. Deleted files or folders are temporarily stored in the Recycle Bin and cannot be restored.

C. Match the columns.

  Column A   Column B

 1. Context menu  (a) Least detailed view

 2. List view  (b) Displays the total number of items

 3. Detail view  (c) Shortcut menu 

 4. Status Bar  (d) Displays all kinds of locations

 5. Left pane  (e) Name, Date Modified, Type and Size 

D. Choose the correct answer.

 1. Which of the following stores the deleted files?

 (a) Folder   (b) Status bar

 (c) Left pane   (d) Recycle Bin

 2. Which of the following is the most commonly used operating systems?

 (a) Windows   (b) Oracle

 (c) Linux   (d) Mac OS

 3. Which of the following is the most used button on the desktop?

 (a) Recycle Bin   (b) Live Tiles

 (c) Start button   (d) Power button

E.  Answer the following questions.

 1. Write the steps to create a folder.

 2. What is the context menu?



Answers to Worksheet

A. 1. Graphical User Interface 

 2. desktop 

 3. Start 

 4. File Explorer

 5. Copying

B.  1. True 2. False 3. True 4. False 5. False

C. 1. (c) 2. (a) 3. (e) 4. (b) 5. (d)

D. 1. (d) 2. (a) 3. (c)

E. 1. Follow these steps to create a folder.
��   Right-click on the blank area of the desktop.
��   Select the New option from the list. A list having options will appear.
��   Click on the Folder option. A new folder will be created on the desktop with a default 

name ‘New Folder’.

 2. Context menu appears upon right-clicking on any icon. It is also called Shortcut menu. An 
entirely different list of options appears upon right-clicking on the blank area of desktop or 
on any object.



4.  More on Scratch

A. Fill in the blanks.

 1. ___________ is a programming language, designed to be fun, educational and easy to learn.
 2. Scratch has its own inbuilt ___________ and ________ editor.
 3. Scratch is a ______________________ language where programming is done by dragging 

blocks from the Block Palette.
 4. The ___________ contains a list of audio clips.
 5. ____________ is a place where we pick and drop the blocks.

B. State whether the following statements are True or False. 

 1. Script area is an area where related instructions are grouped together.

 2. The Costume pane contains a list of costumes of the selected Sprite.

 3. Shrink Sprite tool increase the size of Sprite.

 4.  The backdrop of Stage can be changed by clicking on the Stage backdrop icon present in 
Sprite list.

 5. When we open Scratch, by default the Chicken Sprite is present on the stage.

C. Match the columns.

  Column A  Column B

 1. Script Area (a) Working area to perform actions

 2. Stage (b) Area where related instructions are grouped together

 3. Sprite (c) Place where we pick and drop the blocks

 4. Block Palette (d) Tool reduces the size of Sprite

 5. Shrink Sprite (e) Object that performs actions in Scratch

D. Choose the correct answer.

 1. Which of the following contains a thumbnail view of Sprites?

 (a) Sprites Pane   (b) Stage

 (c) Block Palette   (d) Script Area

 2. In which of the following areas does a Sprite moves and interacts with the Stage?

 (a) Sprites Pane   (b) Stage

 (c) Block Palette   (d) Script Area

 3. The Toolbar contains four different tools to perform different functions. Which of the following 
is not on the Toolbar?

 (a) Duplicate   (b) Delete

 (c) Cut Sprite   (d) Grow Sprite

E. Answer the following questions.

 1. Write the steps to work with two Sprites.

 2. How will you move and rotate a Sprite?



Answers to Worksheet

A. 1. Scratch 2. Paint, Sound 3. drag and drop programming

 4. Sounds pane 5. Script Area

B. 1. False 2. True 3. False 4. True 5. False

C. 1. (c) 2. (a) 3. (e) 4. (b) 5. (d)

D. 1. (a) 2. (b) 3. (c)

E. 1. Follow these steps to work with two Sprites.
�� Open Scratch. Remove the default Sprite by right-clicking on it and select the Delete option.
�� Click on Choose sprite from library. Select the Sprite and click on the OK button.
�� Click on the Choose Sprite from library. Select the Sprite and click on the OK button.
�� Create the block stack.
�� Click on the Green flag button located on the top of the window and observe the two 

Sprites talking to each other.

 2. Follow these steps to move and rotate Sprite.
�� Open Scratch window. Default block, i.e., Motion block will be displayed in ‘Scratch’ window. 
��  Click on the Move 10 steps block and drag it to ‘Script Area’. 
��  You can change the number by typing in the ‘Number’ box. Click on the block. You will 

move according to the mentioned number of steps.
��  Click on Turn 15 degrees block. Again drag and drop on the ‘Script Area’. Change the value 

of degree by typing number and click on the block. You will observe that Sprite will turn/
rotate specified degrees on the Stage.



5. Editing a Document in Word 2016

A. Fill in the blanks.

 1. The starting screen of Word 2016 is known as ________________.
 2. Clicking on the _________________ thumbnail creates a new document.
 3. Making changes in the text is called __________.
 4. _________ text means making the duplicate copy of the text. This is done using the 

____________ commands.
 5. A sentence having grammatical errors is seen with a ___________ line.

B. State whether the following statements are True or False. 

 1. Moving the text means to move the text from its original location to a new location.
 2. The Backspace and Delete keys present on the keyboard are used to delete the text.
 3. Word 2016 has an inbuilt dictionary and a set of grammatical rules to check a document.
 4. An incorrect spelling of a word in the document can be seen with a double orange wavy line.
 5. Footer allows us to find synonyms of a word in the document.

C. Match the columns.

 Column A   Column B

 1. Creating a New Document  (a) Ctrl + A

 2. Saving a File  (b) Ctrl + Y and Ctrl + Z

 3. Selecting the entire document  (c) Ctrl + X and Ctrl + V

 4. Redo and Undo  (d) Ctrl + N 

 5. Cut and Paste  (e) Ctrl + S 

D.  Choose the correct answer.

 1. Which of the following allows us to know the total number of words in a document?

 (a) Thesaurus   (b) Word Count

 (c) Header   (d) Footer

 2. Thesaurus button is present on which group of the Review tab?

 (a) Proofing   (b) Comments

 (c) Tracking   (d) Changes

 3. Ctrl + Y is the shortcut for which of the following commands?

 (a) Undo   (b) Find

 (c) Redo   (d) Cut

E. Answer the following questions.

 1. What is a header? Write the steps to insert a header.

 2. Write the steps to open Word 2016.



Answers to Worksheet

A. 1. Backstage view   2. Blank document   3. editing

 4. Copying, Copy and Paste 5. green wavy

B. 1. True 2. True 3. True 4. False 5. False

C. 1. (d) 2. (e) 3. (a) 4. (b) 5. (c)

D. 1. (b) 2. (a) 3. (c)

E. 1. Header is used to place some information on top of a page. Follow these steps to insert 
the Header.
��   Click on the Insert tab.
��   Click on the Header button present in the ‘Header & Footer’ group. A drop-down menu 

appears.
��   Click on the Edit Header option. You will find ‘Header’ box at the top of a page separated 

by dotted lines.
��   Click on the Header box and type the text. Click outside the Header box. The header gets 

added to the page.
 2. Follow these steps to open Word 2016.

��   Click on the Start button.
��   Scroll down and select Word 2016. The ‘Word 2016’ window will open. The starting screen 

of Word 2016 is known as Backstage view.
��   Click on the Blank document thumbnail to create a new document.



6.  Formatting a Document

A. Fill in the blanks.

 1. Formatting effects can be applied using the _______ tab.
 2. ____________ allows us to emphasise the text as it is highlighted by a marker.
 3. _____________ means position of the text in a document.
 4. A ________ is a small graphic symbol that sets off an item in a list.
 5. __________ feature of Word 2016 allows to enlarge the first letter of a paragraph.

B. State whether the following statements are True or False. 

 1. Editing refers to changing the appearance of a document to make it look attractive.
 2. We can add bullets or numbers to the text we have already typed.
 3. There are two types of formatting in MS Word—Character formatting and Paragraph formatting.
 4. We cannot emphasise the text in a document.
 5. We can add borders and shading to a document.

C. Match the columns.

  Column A    Column B
 1. Make text bold  (a) Ctrl + Shift + V

 2. Make text italics  (b) Ctrl + =

 3. Underline text  (c) Ctrl + I 

 4. Paste format  (d) Ctrl + U 

 5. Change text to subscript  (e) Ctrl + B 

D. Choose the correct answer.

 1. Which of the following groups of the Home tab contains options to format the text?

 (a) Font group   (b) Proofing group

 (c) Comments group   (d) Tracking group

 2.   This button is used for which of the following?

 (a) Underline   (b) Subscript

 (c) Superscript   (d) Strikethrough

 3. Which of the following buttons is used to underline the selected text?

 (a)    (b) 

 (c)    (d)   

E. Answer the following questions.

 1. What is Drop Cap? Write the steps to apply Drop Cap effect.

 2. What are the four options to align text?



Answers to Worksheet

A. 1. Home 

 2. Highlighting 

 3. Alignment 

 4. bullet 

 5. Drop Cap

B.  1. False 2. True 3. True 4. False 5. True

C.  1. (e) 2. (c) 3. (d) 4. (a) 5. (b)

D. 1. (a) 2. (d) 3. (b)

E. 1. Drop Cap feature of Word 2016 allows to enlarge the first letter of a paragraph.

  Follow these steps to apply Drop Cap effect.
��  Select the first word of your document.
��   Click on the Insert tab and select the Drop Cap button in the ‘Text’ group. Select the 

desired option from the drop-down menu. 

 2. Word provides four options to align text: Align Left, Align Right, Center and Justify.
�� Align Left: The text is aligned along the left margin.
�� Center: The text is aligned between the left and right margins.
�� Align Right: The text is aligned along the right margin.
�� Justify: The text is evenly aligned from both left and right margins.



7.  Microsoft PowerPoint 2016

A. Fill in the blanks.

 1. Microsoft PowerPoint is an application software used to make ______________.
 2. A presentation consists of number of pages called _________.
 3. A _________ is an electronic presentation displayed on a computer screen.
 4. _________________ displays all the slides at the same time in a miniature form.
 5. Additional slides can be added by clicking on the ___________ and selecting the 

____________ option in Slides box.

B. State whether the following statements are True or False. 

 1. PowerPoint is used to create and display beautiful presentation.
 2. Slide Distorter View is used to show screen presentation to the audience.
 3. PowerPoint cannot be used to create handout material and speaker’s notes.
 4. Pictures can be inserted in a presentation from a file present on the computer.
 5. Themes provide attractive backgrounds to the slides.

C. Match the columns.

 Column A     Column B
 1. Esc (a) Mouse button to go to the next slide

 2. Click (b) To delete a slide

 3. Right-click (c) Keyboard button to go to the next slide

 4. Enter (d) To return to the previous view

 5. Delete (e)  Opens a pop-up menu which is used to navigate 
the slides

D. Choose the correct answer.

 1. Which of the following is located at the top of the window which shows the name of the 
currently opened presentation?

 (a) Quick Access Toolbar   (b) Title Bar

 (c) File Tab   (d) Ribbon

 2. Which of the following is present on the left side of the window and displays an outline view 
of all the slides?

 (a) Slide Pane   (b) Ribbon

 (c) Status Bar   (d) File Tab

 3. Which of the following is not a part of the view tab?

 (a) Slide Sorter View   (b) Notes Page View

 (c) Slide Delete View   (d) Slide Show View

E. Answer the following questions.

 1. Write the steps to start PowerPoint 2016.

 2. What is a theme? How can you apply a theme to a slide in a presentation?



Answers to Worksheet

A. 1. presentations 

 2. slides

 3. slide show

 4. Slide Sorter View  

 5. Home tab, New Slide

B. 1. True 2. False 3. False 4. True 5. True

C. 1. (d) 2. (a) 3. (e) 4. (c) 5. (b)

D. 1. (b) 2. (a) 3. (c)

E. 1. Follow these steps to start PowerPoint 2016.
��   Click on the Start button.
��   Scroll down the list and click on PowerPoint 2016. A ‘PowerPoint 2016’ window will open. 

 2. A theme is a set of colours, fonts and special effects. Themes provide attractive backgrounds 
to the slides. Follow these steps to apply a theme to a slide in a presentation.
��   Click on the Design tab.
��   Choose and click the desired design to insert it in the slide.



8.  Multimedia and Internet

A. Fill in the blanks.

 1. A __________________ is an orderly display of information using different media elements.
 2. __________ is the multimedia which involves the interaction of the user and the device used.
 3. _______________ is used to play an audio or video CD on a computer.
 4. ___________ is a well-organised and managed network of millions of computers connected 

all over the world.
 5. A ___________ is a collection of web pages containing related information.

B. State whether the following statements are True or False. 

 1. Interactive multimedia does not involve any interaction with the user.

 2. The page on the Internet having information is called the web page.

 3. The main or first page of a particular website is called the website.

 4. A collection of various website is called World Wide Web. 

 5. Software that is used to access information on the Internet is called web browser.

C. Match the columns.

 Column A     Column B
 1. Uniform Resource Locator  (a) Google and Yahoo

 2. Search Engines (b) A collection of web pages

 3. Multimedia programs (c) Play an audio or video CD on a computer

 4. Windows Media Player (d) Unique address of every website 

 5. Website (e) Stored in CD-ROMs and interactive 

D. Choose the correct answer.

 1. Which of the following is not a web browser?

 (a) Mozilla Firefox   (b) Opera

 (c) Google Chrome   (d) Microsoft Office

 2. What is the main or first page of a particular website called?

 (a) Website   (b) Webpage

 (c) Home page   (d) Website

 3. Which of the following icons is present on the Notification Area of the Taskbar?

 (a) Folder icon   (b) Start button

 (c) Network icon   (d) Google chrome icon

E. Answer the following questions.

 1. What are the requirements of a multimedia system?

 2. Write the steps install a program from a CD that does not contain Autoplay.



Answers to Worksheet

A. 1. multimedia presentation 2. Interactive multimedia 

 3. Windows Media Player 4. Internet  

 5. website

B. 1. False 2. True 3. False 4. True 5. True

C. 1. (d) 2. (a) 3. (e) 4. (c) 5. (b)

D.  1. (d) 2. (c) 3. (c)

E. 1. Computers provide an easy way of presenting information by using the media elements 
like text, audio, video, animation and graphics. A computer capable of playing sounds or 
music and showing graphics, videos and texts on the screen is used for playing multimedia 
programs. A multimedia system essentially consists of the following hardware.
�� CD-ROM drive for playing CD
�� Sound card and speakers for producing sound
�� Monitor to display video
�� Microphone and headphone for recording and listening to sound

 2. Follow these steps to install a program, game or utility from a CD that does not contain the 
AutoPlay feature.
��   Insert the CD in the CD-drive.
��   Open This PC by double-clicking on the icon visible on the desktop.
��   Double-click on the drive showing CD or DVD drive to open it.
��   Locate the Set-up file, double-click on it and complete the installation process. Once the 

installation is complete, the program is saved. We can open this program by clicking on 
the Start button and then on the installed program. The program starts on clicking the 
CD-icon.


